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Software License Agreement
Impertant- Before using the enclosed software and documentation, read thas
Ecense carefully.
Using the program diskette means that you agree with these texms. If you do
not agree to these terms, return the program and documentation to UnSane
Creations within seven days and receive a full refund.

Software Copyright

The endlosed software program is protected by both United States copynight
law and international treaty provisions. Itis against the law to copy any poruon
of the software on disk, cassette tape, or sny other medium without prior
written permission of UnSane Creations. UnSane Creations will seek full legal
recourse against violators. You may, however, make backup copies of the
software provided there is no chance that the software will be used by two
different people in two different places at the same time.

Copyright
Copyright © 1989, UnSane Creations. All rights reserved. No part of this
publication may be reproduced, transcribed, copied, ranslated, or reduced to any
electronic medium or machine-readable form without prior written permission of
UnSane Creations, 815 Windingpath L ane, Manchester, Missoun 63021.

Notice
UnSane Creations specifically disclaims all other warranties, expressed or
implied, including, but not limited to implied warranties of merchantability and
finess for a particular purpose. Inno event will Unsane Creations be hable to
you for any incidental or consequential damages anising out of you use or
inability to use the program, even if Unsane Creations has been advised of the
possibility of such damages.

Upgrade Policy

Program Upgrades: We don’t mind copying disks. Send us a blank disk and a
self-addressed, stamped disk modlez. When an upgrade becomes available, we
will copy it to your disk, put it in your meiler, and drop it in the mail. When you
receive your upgrade, send us your old key disk and a new self- addressed,
stemped mailer to receive future upgrades.

Manual Upgrades: All upgrades come with a free one page "What's New"
newsletter. If you wish to receive.a complete revised manual, send us one
dollar and we will send you the new manual when it becomes available.



Calculation Instruction Manual

Intreducton

Thank you for purchasing Celculation; itis a decision you won’t regret. If you
have already seen the Calculation Demo, you're probably familiar with the
game. But even so, take the tme to glance at Getting Started and The Advice
Coalumn_ Ifyou haven’t seen the demo, read the whole manual; a few minutes
of reading might save you a lot of frastration. But most of all, don’t be afraid to
leam by trial and exxor. Calculation is a well designed game that won'’t go
berserk; ifit does, we want to hear aboutit. (The first person to report a
reproducible bug gets two Unsane Creations products free.) Calculation is more
than just another solitaire game; it’s solitaire like you always wished it could
be.

Getting Started

The Calculation Key Disk is a bootable disk with key disk protection. This
means that if you make backup copies or to copy Calculation to your hard disk,
you will be prompted put in the Calculation Key Disk before you can play.

When you open Calculation you will see two versions, Calculation and
Calculation Strip. The Strip version is a 34K version that lacks a few options.
[t1s designed to take up less memory so you can easily multitask, butis
essentially the same. You will also see demos of other UnSane Creations
products. Take the time to look at them and pass them on to your friends.

Calculation stores its scores and other information in a file called “Calculation
Scores” In your $: directory. Among the other information stored in this file is
the seed for the random number generator. Calculation changes this seed every
tme you quit. Ifyou leave a game without quitting, you will play that same
game the next time you play. If you use another disk to boot from, copy the
scores to the $: directory of that disk or assign s: to the Calculation Key Disk.
If you don’t, you’ll find that you’re playing the same games over.

Standerd Rules

For those of you experienced at playing different solitaire games, here is a



quick summary of the rules: The object of the game is stack the cards into four
ordered stacks, one that counts by one, one by two, one by three, and one by
four. The sequence for each stack looks like the following:

Stack1=4A,234,567,8910J),Q,
Stack 2=2,4,6,8,10Q 57,9,
Stack3=369Q258JA 471
Stack4=4,8Q,37J,2610A,5
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Cards are dealt one at a time. A dealt card can either go on one of the stacks, if
it fits, or on the top of one of the four discard piles. Only the top card of each of
the discard piles can be moved to the stacks. For a more detailed explanation,
read on.

The playing field is divided into four areas, see figore 1 below. The four
stacks, the four discard piles, the card—in—play, and the undealt portion of the
deck. The undealt cards ere off to either side. When a card is newly dealt, it
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can either go on a stack or a discard pile. Once itis moved to a stack or discard
pile another card is automatically dealt from the deck until all the cards are
dealt. The four stacks are at the top middle of the screen and the four discard
piles are undemeath. The card-in—play is between the stacks and the discard
piles, symbolic of the choice you must make to its fate.

As cards are deslt, you must put them either on the stacks or the discard
piles. Cards can only be put on thie stacks if they are in the proper order. This
means that at any one time only four different cards can go up to the stacks.



For example, if the first stack, which counts by one, were to have a three
showing, the only card that could go on that sgack would be a fowr. Untll you
placed a four on that stack no other card could go there. Andif a card can’tfit on
any of the four stacks, you must put it on one of the four discard piles. Let’s say
that the computer deals you a five. Let’s ignore the other stacks for a moment
and concentrate on the first one. Since you don’t have a four snd that’s what
the first stack needs, you can’t putit on a stack. You put the five on a discard
pile. The computer deals you a sevennext. You can ether put the seven on the
five, in which case you won’t be able to access the five until you moved the
seven, since only the top card of each discard pile can be moved up to the
stacks, or you could putit on another discard pile. You have to decide if getting
a four is hikely. Ifyou get a four and you put the seven on another pile, you can
put the four and then the five up to the first stack and be that much more shead
of the game. If you put the seven on the five and get a four, you will only be able
to put the four up, but you might not cover another card you need in another
discard pile with the seven. To make things simple you put the seven on
another pile. And low and behold the computer deals you a four. You can now
put the four on the first stack. The next card the stack needs is a five, which
just happens to be at the top of one of the discard piles, so you can now putit on
the four.

The strategy of this game is organizing the discard piles so you can stack the
different stacks sequentially. If the cards come up in the right ordex, the game 1s
easy. If they don’t quite come up in the ordexr you need, then itis all up to how
you organize your discard piles. Only the top card of each discard pile can move
up to the stacks, so including the newly dealt card you have a maximum of five
cards that can move up to the stacks at any one time. As long as theze are
undealt cards, the next card you deal can chenge the game entirely. But when
those cards are gone, winning is determined entirely by the cards you can move
from the discard piles, in other words whether or not the cards you need are
accessible. It may sound like an easy game, but it is one of the most
challenging solitsire games around.

Venations

Calculation allows you to change its rules, giving you a total of two hundred
fifty—six different variations. You can change Calculation’s rules by selecting
Change Rules under the Editmenu. When you do, you see the following
options:

Number of discard piles: 3 435 6



COndy top diseant visahle
All discards visible

Cants cannot he mosed wneng diseants
Cards may be moved to empty discards

Cards go on same color
Canils g0 on iy swt

Undedlt cands nat saakle
Undealt cards visible

Lhseand ples sttt empty
Kings start on discard piles

Stacks start empty
StvhkxstwrwrthA, 2 34

The italicized options are the rules used in standard play. You can vary the
game’s difficulty by changing these options, making Calculation challenging for
anyone, from the youngest novice to the oldest master.

_ The first set of options determines the number of discard piles. It1s possible
to have three, four, five, or six discard piles, although in standard play there are
only four.

The second set of options affects the discard piles themselves. In a standard
Calculation game you can only see the top card of the discard piles. But for
those of us with poor memonies who are too lazy to keep track of the discard
piles on a separate piece of paper, there is this option. It makes every card on
the discard piles visible. Itis stll only possible to move the top caxd of a
discard pile, but now you can see what hies underneath.

The third set controls movement among discard piles. Normally once you
place a card on a discard pile, it stays on that discard pile until you move it up to
a stack or lose the game. But by changing this option, you can move a card from
one discard pile onto another empty discard pile.

The fourth set restricts what cards can be placed on the stacks. Normally the
only restriction on what cards can go to the stacks is numernical. In other words,
if the card is a four and stack two needs a four, it fits. But there can be a further
restriction. You can force it so that cards must also be the same color. In other
words, two stacks would accept only hearts and diamonds and the other two
only clubs and spades.

The fifth set affects undealt cords. Normally, the undealt caxds are off to the
side out of the way, effectively decoration. But this option allows you to see the



undealt cards. You can know what card will be dealt before 1t’s dealt.

The six set determines how the discard piles start in the begmning of a game.
Usually they start empty, but they can start with the Kings on them.

And finally, the seventh set of options similarly determine how the stacks
start in the beginning of the game. Normally they start with the first card
already on them, i.¢. from left to nght, the ace, two, three, and four respectively.
But this option allows you to begin the game with empty stacks.

Mexus

The Project menu contains four possible selections. About contains
irportant information about Calculation. Take the time to look at this at least
once. New Game, or the right Amiga—N key combination, starts a new game.
Same Game, or right Amiga—S, permits those interested in tournament play to
compete with the same game. It dears the Undo/Redo and Cheat buffers just
as if it was a new game. And finally Quit, or right Amiga—Q, allows you to
leave . When you quit, Calculation automatically saves your current position so
when you play Calculation again, you will be exactly where you left off, even f
you were in the middle of a game.

Under the Edit menu there are four more selections. Undo, or nght Amiga-
X, undoes a move. You can undo all the moves from the very end of a game to
the very beginning. Redo, or right Amiga-R, redoes an undone move. Undo
and Redo compliment each other and provide you with a powerful tool for
solving Calculation. Reset Scores, resets Calculation’s scores. For more
information on how Calculation keeps score, see the Scarmg section of this
manual. The final option, Change Rules, pexmits the user to change
Calculation’s rules. For more information on this option, see the Venations
section.

The final menu, the Options menu, contains seven options. The first, Help!,
provides you with an online summary of the standard rules for Calculauon. You
can also get this summary by hitting the 'Help’ key or the night Amiga—H key
combination. This option is not included in the Strip version. The next, Slow
Cards/ Quick Cards controls how cards are moved by the computer to the
stacks. The cards can either move with blinding speed or stately decorum
depending on your preference. The option in use is the opposite of what shows
in the menu, which means that when the cards move with blinding speed, Slow
Cards shows in the menu, and when the cards move with stately decorum,
Quick Cards is visible. The next option, Cheat or right Amiga-C, offexs you
computer aid Furthes information on this option is covered in the Cheating
secton. Background On/Off enables you to turn the background picture on or



off. Like the Slow Cards/Quick Cards option, the menu shows the option not
in effect. This is another option not included in the Strip version. Sound
On/Ofl allows you to switch the sound on or ofl. Normally Calculation tells you
when you pick up a card, when you make a legal move, and when you make a
illegal move with sound. If this becomes snnoying, tum it off with Sound Off.
Next Play On/Of signals the next legal move for each of the four stacks.
When enabled there is & numbex to the left of each stack. This number indicates
the next card you can put on that stack. And finally, Play Signal On/Off
wams you when you're missing a legal move. If there is a legal move, either
the card you just dealt or a card from one of the discard piles, and you deal
another card without taking it, the computer will flash the screen to wam you of
the mistake. Butit will only provide this sexvice to those who have enabled
this helpful feature.

Cheating

There are two ways to cheat. One is to change the rules to make the game
easier. The other is to use Cheat from the Options menu. For information on
how cheating affects scoring, see the Scaring section.

Changing the rules is the easiest way to cheat. [tis very easy to getinto &
situation where you think to yourself, “If I could only do this, I could win the
game." Calculation permits you to do just that and win the game with Change
Rules under the Editmenu. For more information on this option, see the
Variations section.

But if changing the rules doesn’t appeal to you, there is always Cheatin the
Options menu. If you select this option, the computer begins to examine every
possible move among the dealt cards. It will determine, given the time, whether
or not it is possible to win the game from your current posidon. If it finds a way,
it will make one move toward that goal. Selecting Cheat again will cause it to
make another move toward the win. Cheat only makes you weit when it needs
to think, which means that after its finished thinking, it will be spontaneous
unless you’ve changed things significantly. Ifitisn’t possible to win, it will tell
you so. You can then Undo a few moves and try cheating agamn.

Cheat was not designed to solve games from the beginning. The sheex
number of possible moves involved prohibits it. What it does is help you out of
tight situations. If you get the point where you’re stuck and can’t decide what
to do, run Cheat. Near the end of a game it usually gives you an answer
relatively quickly. Take a break for a few minutes and Cheat will probably have
an enswer for you. Ifit doesn’thave an answex by then, it’s likely that there
isn’t a way *o win from that position and Cheat is busy proving you can’t win.



The proof often takes a long time. Ifyou find you can’t walt any longer, press
the left mouse button. You will see a requestor with three options: Quit
Cheating, Keep Working, end Save Work. Quit Cheating stops the
computex snd Keep Working restarts it. Save Work saves the informaton
from the cheat buffer and quits the game. When you start Celculation again, you
will begin cheating whexe you left off.

While the computer cheats you will see an illumnatng new pointer. This
pointer gives you information on how the cheat is progressing. The search
progresses in a tree of all the possible moves from your current position. The
light rays on the pointer chenge when the search moves down another branch.
If the light rays don’t change, it means that the search is progressing down the
same branch and that means that you are probably dose to a solution. It’s up
to you to decide how long to weit. Some solutions, especially those with fewer
caxds showing, occur almost immediately while others can take days or weeks
oX years.

Scormg

The computer keeps a number of statistics: games won I a oW, gamnes won,
games lost, percentage won, longest winning streak, and longest losing streak.
And it keeps track of each of these statistics for each possible game vanaton.
If you use Cheat you will get a warning saying that if you continue the game
will count as a loss. Likewise if you Change Rules in the middle of a game
you will elso get a warning; the computer assumes that you're making them
easier. In both cases, it will record a loss for the game you're playing to the
rules you started with. The only time you won’t receive these messages when
you begin to cheat is if you are replaying a game you've already won or lost,
you've been accorded a win or aloss, so1it doesn’t matter. You can change
certain roles in the middle of a game and not affect your score. The number of
discard piles and how the discard piles and stacks begin a game can’t be
changed until the next game, so they don’t affect the score of the game you're
playing. And finally, you can reset these scores by using the Reset Scores
option undexr the Editmenu.

The Advice Calumn

1. Don’t start with the standard rules. Start simply and make Calculation fun
as well as challenging. Some good rules to change are “number of discard piles:
&, *all discards visible’, and *kings start on discard piles.” If the game is stll



too hard, change a few more rules. The point is to leam to play Calculation
without getting frustrated. After all, aren’t games supposed to be fun?
2 Keep a card by your side of the following:

Al2]314]5 |67 |8]9 |10]J]Q |K
214|618 |10JOJA|3]5|7 |9 |K
316191Q 2 |5 |8 |J|A|4]7]10]K
4181Q 137 ]J |2 |6[10]A|5]9 |K

Ifyou are too lazy to make a card, hit the help key.

3. Leave one discard pile free to accept kings. Don’t put any other cards on
this pile until you have all four kings theze. Kings are the last card to be put on
each of the stacks, which means that any cards under a king are eflfectively
useless until the end of the game. If you happen to need those cards to win
you’re out of luck. The quickest way to insure you’ll never win a game is to put
a king or two on a card that you need.

4. Always work first from the discard piles. If the computer deals you a card
you need, first check the discard piles. If the card you need is also on a discard
pie useit. This way you free the card undemeath. You might find that you
need that one also. Ifyou don’t need it you can always place the newly dealt
card on top and retum things to way they were before.

3. Try to build sequences in the discard piles. For example, place the four on
the five and the three on the four. Then when youneed the three for the first
stack, you also get the four and the five. But remember, don’t build sequences
you will never use. Don’t put the three and four on the five if the first stack is
already up to the seven. '

6. Try not to cover cards you will be using soon. If you will be using the
queen soon, try to keep it at the top of a discard pile. If you coverit, you won’t
be able to get to it, and getting to it quickly may force you to cover other cards
youneed.

7. Don’tmake impossible sequences. Don’t put a queen on the only
remaining jack in the game or all the kings on a four. It only takes one
impossible sequence will lose the game.

8. Use Undo. Use it when you’re in rouble. Use it when you make a
mistake. Butuse it, even if you have to Undo to the start of & geme. Undoing
is not cheating. You can always Redo an undone move.

9. If in time, Calculation becomes too easy, make it harder. The ability to
change Calculation’s rules not only provides you with the means to make
Calculation easier, but it also allows you to make it harder. Calculation can be
made tivially easy or virtually impossible. It’s up to you.

10. And finally, like many other prominent psychologists, astrologists, and



Advice Columnists, I may not have the slightest idea what I am talking about.
Use your own judgement.

Ruamars

Steve, Calculation’s programmer, has been known to complan ademandy
about the Rumors section of UnSane Creation’s manuals. Some rumors have
him pegged as an alien from anothex planet, some as a two headed Elvis clone,
and even one as a descendant of a rabbit-hke creature. Buthe has always
been a firm believer in the freedom of the press, and when that fails he can
always be mollified with a caxrot. Ifyou wish to speak to Steve, about
Calculation, the current UnSane rumors, or anything else for that mattey, feel
free to contact him at (314) 892- 5367 or write to him c/o:

UnSane Creations
815 Windingpath Lane
Manchester, MO 63021
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